Basic APA Tips
Compiled by Caren Putzu, PhD, MSW, MPA
(Please note: This tip sheet is not intended to encompass all possible examples of APA formatting, but rather provide some basic information regarding APA.)

This Tip Sheet is intended to go along with the APA Formatting Presentation, which can be found in your Library Guide.

BEGINNING WITH THE TITLE PAGE

Your papers should always begin with a title page. Figure 2.1 in your APA manual provides an example of a title page, although there is additional information on that example that most instructors will probably not expect you to include. Below is an example of a title page. Make sure you check with your instructor for their title page requirements.

<table>
<thead>
<tr>
<th>Running head: ANALYSIS OF NORMAL PARK</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>An Analysis of the Normal Park Community</td>
<td></td>
</tr>
<tr>
<td>Caren L. Putzu</td>
<td></td>
</tr>
<tr>
<td>Eastern Michigan University</td>
<td></td>
</tr>
</tbody>
</table>

FORMATTING YOUR PAPER

Getting that pesky Running Head in the correct place (Visit Figure 2.1 in your APA manual to see what this will look like)

1. Press “enter” down to about half-way down the page and then type your title (note, even if you don’t have a title yet, just type something)
2. After you press “enter”, go to “Insert” and above “Pages” click “Page break”
3. Begin typing a few words on the 2nd page
4. Click your cursor somewhere on the 1st page
5. Still in the “Insert” section, above “Header & Footer” click “Page Number”, select “Top of the page” and select the first option (number on the left side of the page)
   a. The header will appear with the number 1 in the top left-hand corner
   b. The top bar will now be on the “Design” tab
6. In the “Options” section, click “Different first page”
7. Highlight the number 1 and click the “Home” tab at the top
8. Change your font to match the font you are using in your paper
9. Place your cursor before the number 1 and type “Running head: ABBREVIATED TITLE” (note, you will type a version of your abbreviated title, not the entire title unless it is very short)
10. Next hit “Tab” usually twice to get the number 1 to the far right-hand side of the page
11. Go to the 2nd page and put your cursor in front of the number 2
12. Type in the same ABBREVIATED TITLE that you used before (Do NOT include the words “Running head:”)
13. Hit “Tab” until the number 2 is on the far right-hand side of the page
14. At the end, go back to the “Design” tab and click “Close header and footer”

CITATIONS

In your paper, you will be citing your references in two different places and in two different ways. The in-text citation is exactly as it sounds- the citation you put in the body of your paper. The APA manual states that you will use in-text citations to give credit to “…the work of those individuals whose ideas, theories, or research have directly influenced your work” (2010, p. 169). You should provide an in-text citation if you quote an author, paraphrase an author, as well as to provide documentation for any statistics or assertions you make (unless you state in the paper that you are making the assertion). The references section is where you list all of the citations that were included in your paper and only those citations. This is different than some other formats where you have a bibliography and you may have citations that are not in the body of your paper.

My recommendation is that as you are writing your paper and you need to cite something, type the entire citation in the references section and then go back and type the in-text citation in your paper. This ensures you have the correct information included in the in-text citation and that you don’t forget anything! Given this recommendation, I provide some hints for the references section first and then provide hints for the in-text citations.

REFERENCES PAGE

All references cited in the text of a paper must be listed alphabetically by the first author's last name and double-spaced. If there are multiple references with the exact same author, the references are listed by year of publication with the earliest one first. If you have more than one reference where the author(s) and date of publication are exactly the same, list them alphabetically by the title and place lower case letters (a, b, c, etc) immediately after the year and within the parenthesis (see example on page 4). Chapter 7 gives numerous reference examples. In addition, section 6.25 provides a thorough list of ordering in the reference list. A few notes regardless of the type of source material:

- There is a space between the first and middle initials of the author(s)
- In the title of the work, only capitalize the first word, first word after a colon, and any proper nouns

Journal article

The general format is:


For example:

Note:
- Each word in the journal title is capitalized with the exception of the conjunctions
- Italicize the title of the journal and the volume number

Books
The general format is:


For example:


Note:
- Any kind of information about edition or volume goes after the title and is **not** italicized
- If there are several locations of the publisher, pick the one that is closest to your current location
- If the publisher is also the author, put “author” instead of the name again

Websites
If you are able to download a pdf from a website, you will use the journal or technical report format (see section 7.03 for technical and research reports). That means that you will not use the information below. However, you will add “Retrieved from http://www.copyandpastethefullwebsitehere.com/evenifitislong/andhaslotsof_symbols.html” at the end of your citation.

For information you may collect on a website (not downloaded), if an author is listed you will use that author. If the author is listed as the agency or institution, the general format will be:

Agency Name. (year, month day). Title or section heading of where information was retrieved [Website].

Retrieved from http://www.makesureyoutypeinthefulladdress.org/I_recommend_copy_and_paste

For the title, use the tab or the area of the website where you are retrieving the information. For example, if you are in the “About” section or the “History” section, that is your title. For the date, look at the bottom of the website and see if there is a date. If the month and/or day is not available, don’t worry about it. However, because online material can change so rapidly, you should include the month and day if it is provided. If there is no year provided, use “n.d.” which stands for “no date”.
The Annie E. Casey Foundation. (2016, November 21). Year one of the rural IMPACT project [Website].

Note:
• If the author is the name of an agency, the agency does NOT have a first and last name. In other words, you would not reorder The Annie E. Casey Foundation to be Foundation, The Annie E. Casey!
• If an agency begins with word “the” (such as this example), you utilize the next word when alphabetizing.
• You must provide the full URL of where you were in the website. The idea is that someone could copy and paste the URL and land in the exact spot of the website where you found your information.
  o This means that if you go to several different sections of a website, you need a separate citation for each one!

If the webpage does not provide an author, the title moves to the first position of the reference entry


The “Other” (Power points, pamphlets, board manuals, and similar types of materials)
*Note- check APA manual to determine if an example is already in there for some types of formats. If not, this section may be helpful.

These odd types of materials will still follow a similar format and you will insert the appropriate information.

For materials that you have in hand and were not downloaded:

Author, A. A. (year, month day). Title of the work [Description of form]. City, State: Publisher.

For materials that were downloaded, follow the same format and rules above except to add “Retrieved from” and the website address (see example under “Websites”).

For agency materials, you will often find that they printed their own materials and it will not state where it was published and by whom. In those instances, the default is the location of the agency and the publisher is the same as the agency, and therefore you will put “Author” for publisher name. For example:


Be careful if a specific person in the agency is the author, but the agency published the material. The name of the author and the name of the publisher will be different!

If you have multiple citations with the EXACT same author and EXACT same year, you must use a, b, c, etc. following the year to distinguish between the citations. They will be listed by alphabetical order of the title since the author and year are the same (if the author and year are not the same, they will be listed by that). See section 6.25 in your APA manual for detailed instructions.

In this example, you can see the author (U.S. Census Bureau, American Community Survey) and the year (2016) is the same for all three citations. The citations are first put in alphabetical order by the title. In this case, they all start with “Table” and then a letter and series of numbers. The citations are arranged by the letter and then the number. Once they are in alphabetical order, a, b, or c is added after the year (with no space) to identify each of them.


Making the References section look neat and tidy
I highly recommend typing in all of your citations first, and then go back and follow these steps for the formatting

1. Highlight all of your citations
2. In the “Home” tab, under “Paragraph”, click the little arrow at the bottom right side of the box
3. Under “Special” (middle right side of box) in the drop-down box select “Hanging” and the default should be 0.5”
4. If under “Spacing” you see a number, change them both to 0

IN-TEXT CITATIONS
Chapter 6 of the APA manual provides detailed information on in-text citations. In particular, Table 6.1 is extremely helpful in regards to multiple authors. Here are a few tips to get you started:

Use the author-date format to cite references in text. For example:

As Smith (2009) points out, the sky is known to be blue.
A recent study (Smith, 2009) suggests that the sky is blue.
One person believes that the sky is blue (Smith, 2009).

Using the journal example on the preceding page, the first citation will look different from subsequent citations due to having multiple authors. For example:
In a recent study, providing non-custodial parents with statements of their child support payments and any arrears was found to increase the amount of child support arrears collected (Plotnick, Glosser, Moore, & Obara, 2015).

Later on in your paper you come back to this article: Although an intervention such as providing statements had some effectiveness, the actual cost of the intervention may have outweighed the overall benefits (Plotnick et al., 2015).

Using the example of multiple citations with the same author and year (the U.S. Census website example), here is an example:

Within the Normal Park Neighborhood, 17.1% of the households earn less than $10,000 a year (U.S. Census Bureau, American Community Survey, 2016c). Yet, 73% of the residents use their own vehicle to get to work (U.S. Census Bureau, American Community Survey, 2016a).

**Multiple citations** - If you are using multiple citations, list them in alphabetical order by last name and separated by a semi-colon. For example:

Several studies have found that the sky is blue (Popper & Tanker, 2013; Smith, 2009).

**Acronyms** - If the author is an agency or institution that has an acronym that is normally used (meaning, you cannot create acronyms!) and you are going to cite it more than once, you must use the full name the first time and then in subsequent citations you can use the acronym. For example:

School dropout rates are disproportionately higher for minority youth (Institute for Education Sciences [IES], 2013). Dropout rates are also disproportionately higher for low-income youth (IES, 2013).

**Quotations** - The previous examples were all under the assumption that you are paraphrasing the material. If you are directly quoting a source, you must include the page number in the citation. The citation always appears outside of the quotation marks and the period follows at the end. For example:

The authors further contend that “a lack of blue sky can be harmful to your health” (Popper & Smith, 2013, p. 89).

OR

Popper and Smith further contend that “a lack of blue sky can be harmful to your health” (2013, p. 89).

If you are citing an electronic document or something that does not have page numbers, you can use paragraph numbers or section numbers (see section 6.05 in APA manual). You must always include a way to find the material.

**Personal communication** - when your source is from an interview (in person, via phone or skype, or email correspondence), give the first (and middle if you have it) initial and last name of your source along with the date that you spoke to that person. If you had multiple interviews, you may have multiple dates. For example:

One area of town has found that the sky is not as blue (T. L. Potterson, personal communication, April 1, 2014).

Mr. T. Potterson, a resident of the community, noted that the sky is not as blue (personal communication, April 1, 2014)

**Note** - personal communications are the only citation that will not appear in your references list.